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This document is provided to customers who have purchased Molecular Devices equipment, software,
reagents, and consumables to use in the operation of such Molecular Devices equipment, software,
reagents, and consumables. This document is copyright protected and any reproduction of this
document, in whole or any part, is strictly prohibited, except as Molecular Devices may authorize in
writing.

Software that may be described in this document is furnished under a non-transferrable license. It is
against the law to copy, modify, or distribute the software on any medium, except as specifically
allowed in the license agreement. Furthermore, the license agreement may prohibit the software
from being disassembled, reverse engineered, or decompiled for any purpose.

Portions of this document may make reference to other manufacturers and/or their products, which
may contain parts whose names are registered as trademarks and/or function as trademarks of their
respective owners. Any such usage is intended only to designate those manufacturers’ products as
supplied by Molecular Devices for incorporation into its equipment and does not imply any right and/or
license to use or permit others to use such manufacturers’ and/or their product names as trademarks.

Each product is shipped with documentation stating specifications and other technical information.
Molecular Devices products are warranted to meet the stated specifications. Molecular Devices makes
no other warranties or representations express or implied, including but not limited to, the fitness of
this product for any particular purpose and assumes no responsibility or contingent liability, including
indirect or consequential damages, for any use to which the purchaser may put the equipment
described herein, or for any adverse circumstances arising therefrom. The sole obligation of Molecular
Devices and the customer's sole remedy are limited to repair or replacement of the product in the
event that the product fails to do as warranted.

For research use only. Not for use in diagnostic procedures.

The trademarks mentioned herein are the property of Molecular Devices, LLC or their respective owners. These trademarks may not
be used in any type of promotion or advertising without the prior written permission of Molecular Devices, LLC.

Patents: http://www.moleculardevices.com/patents

Product manufactured by Molecular Devices, LLC.
3860 N. First Street, San Jose, California, 95134, United States of America.
Molecular Devices, LLC is ISO 9001 registered.
©2019 Molecular Devices, LLC.
All rights reserved.
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Safety Information

Information about the safe use of the instrument includes an understanding of the user
attention statements in this guide, the safety labels on the instrument, precautions to follow
before you operate the instrument, and precautions to followwhile you operate the
instrument.
Read and observe all warnings, cautions, and instructions. Themost important key to safety
is to operate the instrument with care.

WARNING! If the instrument is used in a manner not specified by Molecular
Devices, the protection provided by the equipment might be impaired.

Warnings, Cautions, Notes, and Tips
All warning symbols are framed within a yellow triangle. An exclamation mark is used for
most warnings. Other symbols can warn of other types of hazards such as biohazard,
electrical, or laser safety warnings as are described in the text of the warning. Follow the
related safety information.
The following user attention statements can display in the text ofMolecular Devices user
documentation. Each statement implies the amount of observation or recommended
procedure.

WARNING! A warning indicates a situation or operation that could cause
personal injury if precautions are not followed.

CAUTION! A caution indicates a situation or operation that could cause damage to
the instrument or loss of data if correct procedures are not followed.

Note: A note calls attention to significant information.

Tip: A tip provides useful information or a shortcut, but is not essential to the
completion of a procedure.
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Symbols on Instrument Labels
Each safety label found on the instrument contains an alert symbol that indicates the type of
potential safety hazard related to the label. The following table lists the alert symbols that
can be found on Molecular Devices instruments.

Symbol Indication

Indicates a warning for a situation or operation that could cause personal injury if
precautions are not followed. There are specific details written next to the warning
symbol.

Indicates a potential electrical-shock hazard from a high-voltage source. All safety
instructions must be read and understood before proceeding with the installation,
maintenance, and servicing of all modules. Power off the instrument and disconnect
the power cord before you do maintenance procedures that require removal of a
panel or cover or disassembly of an interior instrument component.

Indicates a potential pinch hazard.

Indicates power on. SeePowering On the System on page 13.

Indicates power off. See Powering Off the System and the Software on page 13.

Indicates the location of a fuse.

Indicates the instrument manufacture date.

Indicates CSA certification.

Indicates European technology conformity.
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Symbol Indication

Indicates compliance with Australian radio communication requirements.

Indicates compliance with Chinese RoHS Pollution Control Requirements.

Indicates compliance with the Waste Electrical and Electronic Equipment (WEEE)
Directive of the European Union.You must not discard this electrical or electronic
product or its components in domestic household waste or in the municipal waste
collection system.

For products under the requirement of the WEEE directive, contact your dealer or
local Molecular Devices office for the procedures to facilitate the proper collection,
treatment, recovery, recycling, and safe disposal of the device.

Indicates that there is an authorized representative in the European community.

Indicates the instrument manufacturer.

Before Operating the Instrument
Make sure that everyone involved with the operation of the instrument has:

Received instruction in general safety practices for laboratories.

Received instruction in specific safety practices for the instrument.

Read and understood all Safety Data Sheets (SDS) for all materials being used.

Electrical Safety
To prevent electrically related injuries and property damage, inspect all electrical equipment
before use and immediately report all electrical deficiencies. Contact Molecular Devices
Technical Support to service equipment that requires the removal of covers or panels.
The instrument must be connected to a properly grounded power outlet to protect from the
risk of electric shock. Themain chassis of the instrument is grounded together with all
related electrical components.
In the event of a liquid spillage into themain cavity of the instrument, disconnect themains
power supply before trying to clean up.
Do not remove the fixed covers, as there are no user-serviceable parts inside. All electrical
work must be referred to Molecular Devices approved service personnel.
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If the external covers on the instrument are removed, the power supply does not
automatically stop.

WARNING! HIGH VOLTAGE Power off the instrument and disconnect the
power cord before you do maintenance procedures that require removal of a
panel or cover or disassembly of an interior instrument component.

Do not try to use the instrument until all covers are replaced.
To provide access for disconnecting power from the instrument, maintain a 66 cm (26 in.)
minimum clearance area on the right side of the instrument.
To protect against fire hazard, replace the fuses only with the same type and rating as the
original factory-installed fuses.

Chemical and Biological Safety
Normal operation of the instrument can involve the use ofmaterials that are toxic,
flammable, or otherwise biologically harmful. When you use such materials, observe the
following precautions:

Handle infectious samples based on good laboratory procedures and methods to
prevent the spread of disease.

Observe all cautionary information printed on the original containers of solutions before
their use.

Dispose of all waste solutions based on the waste disposal procedures of your facility.

Operate the instrument in accordance with the instructions outlined in this guide, and
take all the required precautions when using pathological, toxic, or radioactivematerials.

Splashing of liquids can occur. Take applicable safety precautions, such as using safety
glasses and wearing protective clothing, when working with potentially hazardous
liquids.

Observe the applicable cautionary procedures as defined by your safety officer when
using hazardous materials, flammable solvents, toxic, pathological, or radioactive
materials in or near a powered-up instrument.

WARNING! Never use the instrument in an environment where potentially
damaging liquids or gases are present.
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Moving Parts Safety
The instrument contains moving parts that can cause injury. Under normal conditions, the
instrument is designed to protect you from thesemoving parts.
To prevent injury:

Never try to exchange labware, reagents, or tools while the instrument is operating.

Never try to physically restrict themoving components of the instrument.

WARNING! Do not attempt to access the interior of the instrument unless
specifically instructed to do so. The moving parts inside the instrument can cause
injury. Do not operate the instrument with any covers or panels removed.

Note: Observe all warnings and cautions listed for all external devices attached to or in
use during the operation of the instrument. See the applicable user guide for the
operating and safety procedures of that device.

Cleaning and Maintenance Safety
Observe the cleaning procedures outlined in this guide for the instrument.
Do the following before you clean equipment that has been exposed to hazardous material:

Contact the applicable Chemical and Biological Safety personnel.

Review the Chemical and Biological Safety information contained in this guide.

Perform only themaintenance tasks described in this guide. Contact a Molecular Devices
service engineer to inspect and perform a preventivemaintenance service on the instrument
each year.

WARNING! BIOHAZARD. It is your responsibility to decontaminate
components of the instrument before you return parts to Molecular Devices for
repair. Molecular Devices does not accept items that have not been
decontaminated where it is applicable to do so. If parts are returned, they must be
enclosed in a sealed plastic bag stating that the contents are safe to handle and
are not contaminated.
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Chapter 1: Introduction

The CloneSelect™ Imager system is an automated CMOS camera-based system for imaging
and confluence determination of cells growing in microplates.

Note: The CloneSelect Imager system is strictly for research use only and is not
intended or recommended for the diagnosis of disease in humans or animals.

WARNING! If the instrument is used in a manner not specified in this guide, the
protections provided by the equipment can be impaired.

Workflows
The CloneSelect Imager system uses the following workflow processes:

Imaging

Analysis on page 12

Reporting on page 12

Verifying Monoclonality on page 12

Imaging

Use adherent or settled suspension cells in a microwell plate.

Figure 1-1: 96-well microplate and white light image

1
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Analysis

Display cell confluence and cell number estimation for each well and calculate growth curves.

Item Description

1 Well selection

2 Cell distribution highlighted by software overlay

3 Cell confluence and cell number estimation for each well

4 Repeat over several days

Reporting

Track and view growth of every cell line, and store plate data, including cell confluence, cell
number estimation, and growth curve.

Verifying Monoclonality

After initial seeding, image every well, at any time point, using the loci of growth functionality
to highlight those wells that contain a single colony. See Loci Count on page 52 and
Monoclonality Workflow on page 57.
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Before You Start

CAUTION! Before using the instrument, it is very important that you read this guide
and understand all the safety instructions. Then follow the procedures in the
Powering On the System on page 13.

Powering On the System
Before continuing, do as instructed in Before You Start on page 13.
To power on the CloneSelect Imager:

1. Turn on the CloneSelect Imager. See Status Lights on page 15.

2. Wait for the Ready light to illuminate.

3. To warm up the instrument, leave the CloneSelect Imager in the Ready state for more
than 5minutes. When the unit is cold to the touch, wait for 30minutes.

4. If the computer is powered off, power on the computer.

5. Double-click the desktop icon to start the CloneSelect Imager Software.

CAUTION! Do not start the software before the instrument is powered on and
warmed up.

Rebooting the CloneSelect Imager

If you have to reboot the instrument:

1. Power off the instrument. See Powering Off the System and the Software.

2. Wait for 30 seconds.

3. Power on the instrument. See Powering On the System on page 13.

When the Ready light illuminates, the instrument is ready to use.

Powering Off the System and the Software
To power off the CloneSelect Imager:

1. To exit the CloneSelect Imager Software, on theMain Navigation screen, select File >
Exit.

2. To shutdown your computer, click Start > Shut down, and then wait for computer to
power off completely.

3. To power off the instrument, on the left side of the instrument, toggle the power switch
to off.
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Chapter 2: Instrument Overview

The CloneSelect Imager system is used to image every well to count colony number,
estimate colony area and track colony growth.
Before operating the instrument or doing maintenance operations, make sure that you are
familiar with the safety information in this guide. See Safety Information on page 5.

Item Description

1 Power Connection Port and Power Switch

2 Status Indicator Lights

3 Microplate Holder

Table 2-1: CloneSelect Imager Overview

For technical specifications, see Technical Specifications on page 103.

Status Lights
The status lights on the front of the instrument indicate the instrument activity.

2
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Microplate Holder
Themicroplate holder consists of a glass plate surrounded by a vacuum bed seal. The
microplate is placed on themicroplate holder so that the skirt is over the vacuum bed seal.
When themicroplate holder retracts into the instrument for imaging, themicroplate is
pushed into the back right corner of themicroplate holder into the correct position for
imaging.
Before imaging, a vacuum is applied under themicroplate that holds it down flat on the glass
plate so that all the wells are in the same focal plane. This eliminates the need to autofocus
on every well.

CAUTION! The plate skirt of the plate needs to be intact for the vacuum seal to work.

Leveling Feet

If needed, adjust the leveling feet by loosening the locking nuts and turning the feet until the
instrument is level and stable. After you make adjustments, tighten the locking nuts.

Setup

Locating the CloneSelect Imager

Place the CloneSelect Imager on a stable, level surface. Level the instrument by loosening the
locking nuts and turning the levelling feet to ensure that the CloneSelect Imager is stable and
not able to move. After adjustment, tighten the locking nuts.
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Computer

Note: Molecular Devices is responsible for installing the CloneSelect Imager Software
during your initial instrument installation and configuration.

The CloneSelect Imager ships with a computer with special hardware and software to
support the imaging function.

CAUTION! Do not attempt to use any other computer or change the operating
system to operate the CloneSelect Imager.

The computer includes Windows 10. To connect to your network, security configuration is
required. When that is done, ensure that no changes aremade to the configuration of the
private network connection to the CloneSelect Imager because that stops it operating.

CAUTION! Do not change the standard English settings. If these settings change, the
performance of the system can be impacted.

For software upgrades, see Upgrading Software on page 92.

Connecting the CloneSelect Imager

The connections to the CloneSelect Imager are on the connections panel on the left side of
the instrument.

Item Description

1 Ethernet port

2 USB 3.0 CMOS camera port

3 On/Off switch

4 Fuse

5 Mains port

Table 2-2: Connections and Power Switch Panel
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Connect themains cables to the CloneSelect Imager, the computer and to themonitor
beforemaking the network connections.
The connection to the CloneSelect Imager is a private Gigabit Ethernet link and the
connection must bemade to the computer add-on card Gigabit Ethernet port.

Using Barcodes
If you use barcodes, the following barcode parameters are required:

Use a legible barcode of the following types: 2D barcodes with code 11, 39, 93 and 128

Place the barcode consistently on one of the short sides of the plate.

For troubleshooting, see Troubleshooting Barcodes on page 99.
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Chapter 3: Software Overview

The CloneSelect Imager Software controls the CloneSelect Imager instrument and is based
around the concept of the instrument running processes. Using the default set of processes,
you can modify and save them.
To start the software, from theWindows desktop, double-click the CloneSelect Imager icon.
When the software first starts, the Navigation screen displays theNew Process tab (Figure 3-
1). Processes aremanaged from the Navigation screen. Selecting a process takes you to the
chosen process start-screen from where you can set the properties of the process and run it.
See Process Properties Screen on page 24.

Figure 3-1: CloneSelect Imager Software Navigation Screen

Note: The options that appear on the start up screen depend on the features you
purchased.

3
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Menu Options
The available options in themenus at the top of the Navigation screen change depending on
the screen view and selections.

File Menu

Open Process allows you to open a previously saved process.

Save Process saves the current process.

Save Process As allows you to save the current process with a different name or
location.

Close Process closes the current process and returns you to the Process Selection
Window.

Save As Template saves the current process as a template that can be used for creating
new processes.

Recent Processes allows you to select and open a recent process.

Switch User can be used in a multiple user environment to log off the current user so
that a different user can log on.

Exit closes the Navigation window and shuts down the software.

View Menu

Properties displays the properties of the process that is being set before starting the
process.

Progress displays the progress of a running process.

Administrate Properties lets you change the Properties view and default values.

Tools Menu

Configuration displays the Edit Configuration dialog.

CAUTION! Changing the settings from this menu can cause the device to be
inoperable. Proceed with caution and create a restore point beforemaking any
changes.

Prepare Error Report starts the Error Reporting Wizard to create a data file containing
the configuration and recent log files to help troubleshoot your problem.
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Help

About displays the version numbers of the softwaremodules.

Online Support displays the support web page. This option requires an active internet
connection.

Help View displays the online help file.

Navigation Screen
The Navigation screen is the CloneSelect Imager Software start-screen from which you select
to run processes. Using the right-click option menu, you can view the process options as
icons (Figure 3-2) or as a text list (Figure 3-3).

Note: Available processes will vary depending on your system configuration.

Figure 3-2: The Navigation screen with process options as icon view
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Figure 3-3: The Navigation screen with process options as text list view
The Navigation screen includes the following functionality:

Open Process button displays theOpen dialog where you can select and open a saved
process file. Can also be opened using the File > Open Processmenu option.

Connection Status appears in the bottom right corner of the Navigation screen and
displays the status of the Ethernet connection between the computer and the
CloneSelect Imager.

New Process Tab displays the available processes, which are grouped into the following
categories:

CloneSelect Imager Processes

Maintenance Processes

Utility Processes

(Optional)Automation Process—Available only if optionally purchased to use to
integrate the CloneSelect Imager with other devices, such as automated incubators
or robotic arms.

See New Process Options on page 23.

Recent Processes Tab displays a list of recently opened processes. This is the same list of
processes available from the File > Recent Processesmenu option.
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New Process Options

TheNew Process tab of the Navigation screen gives you a full set of options for creating and
managing processes and system maintenance.

CloneSelect Imager Processes

CloneSelect Imager Processes include the following:

Image Microplate does standard imaging ofmicroplates, saving the images and results
for later review.

Batch Microplate Imaging does imaging of batches of plates with the same
configuration without reviewing the focus and alignment between plates.

Review Results displays results from previous runs including confluence, cell number
estimation, and monoclonality analysis for reviewing.

E-Scope does single high-resolution image ofmicroplates. Images are not saved.

(Optional) Image Microplate High Resolution does high-resolution imaging of
microplates, saving the images and results for later review.

Note: The Image Microplate High Resolution option also includes a camera
upgrade. For more information, contact Molecular Devices.

Maintenance Processes

Maintenance Processes include the following:

Plate Alignment runs the procedures for calibrating the instrument.

Eject Plate Carrier ejects the plate carrier for cleaning and removal ofmicroplates.

Utility Processes

Utility Processes include the following:

Result Location Administrator lets you manage where the results get located.
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Process Properties Screen
The process starts and ends on this Summary screen. Process properties can be edited using
either of the three display options.

Display Options
There are three options for selecting the way in which the process settings can appear for
editing:

Summary is the default display option. The current settings for the process appear
grouped in categories. Click on the category heading to open a screen where the relevant
settings can be changed using drop-down menus.

Details offers the current process settings displayed in drop-down menus from which
they can be edited directly.

Guide steps you through the setup process like a wizard with Back and Next buttons to
scroll through the settings. When all the settings are done, you return to the Summary
view.

Shortcuts
On the right side of the Process Properties screen there are shortcuts to frequently used
menu options.

Connection Status
The status of the Ethernet connection between the computer and the CloneSelect Imager
appears in the bottom right corner of the Process screen.
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Chapter 4: Running Processes

This section explains in detail how to run the following processes on the CloneSelect Imager.

ImageMicroplate, see page 25

E-Scope, see page 85

Review Results, see page 40

Eject Plate Carrier on page 88

Image Microplate
ImageMicroplate is the default process for imaging cells in microplates to determine their
confluence and carry out further analysis, such as cell number estimation and loci counting.
Image resolution in this process is 3.5 µm.
To enter an ImageMicroplate process, in the Navigation screen, click Image Microplate. See
Navigation Screen on page 21. Alternatively, you can open a previously saved Image
Microplate-based process from the Recent Processes tab.
To set the properties for the ImageMicroplate process, the process screen opens in the
Process Properties screen in the Summary view. See Process Properties Screen on page 24.
Change the screen view, as needed, and change properties as needed.
Alternatively, to create your new process, you can use the shortcuts menu on the right side
of the screen to do any of the following Create New Process start tasks:

From template—Starts the new process from a template file.

From file—Starts the new process from a previously saved file.

4
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The ImageMicroplate process involves the following tasks:

1. Set Properties, see page 26

2. Select Source, see page 28

3. Load Plate, see page 29

4. Focus, see page 30

5. Alignment, see page 32

6. Imaging, see page 33

7. Results, see page 36

8. Remove Plate, see page 38

9. Finish, see page 39

Set Properties

Set the properties for the ImageMicroplate process you want to run.

Figure 4-1: Process properties Details view
To set process properties, do the following:

1. On themain screen, select Details.

2. In the Source section, forWell plates, select your microplate from the list menu.

Note: To image a plate type that does not appear in the list, contact Molecular
Devices. See Obtaining Support on page 101.
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3. If you are using barcodes, in the Barcodes section, select the Read barcode check box.

Tip: If barcode reading is enabled and the instrument fails to read the barcode, a
dialog appears to let you manually enter the barcode. Also, if needed, you can
edit the barcode or namewithin Review Results. See Review Results on page 40.

4. In the Setup section, specify the following:

Review focus—When enabled, before imaging a microplate, allows you to check the
focus and brightness settings. Opens the Focus dialog. See Focus on page 30.

Tip: You can also save individual images from the Focus dialog.

Auto focus before run—When enabled, before imaging themicroplate, an
auto-focus procedure runs on the instrument.

Tip: If you are working with a sample that does not have wells with high
contrast cells included, leaving this function disabled.

Scan type—Select one of the following scan methods from the list menu:

Full Scan—Images the entire area of each well in themicroplate. This setting is
recommended for monoclonality applications.

Partial Scan—Images an area from the center of each well.

Tip: This speeds up imaging. Suitable when the data from the center of
each well is representative of the whole well.

Enhance Images—When enabled, to enhance images for display, the background is
flattened. This setting is recommended for monoclonality applications.

Processing Type—Select one of the following cell and colony detection processing
types from the list menu:

Cell Detection Method 1—Formally know as Typical Adherent Cell Confluence,
this algorithm is ideal for settled suspension cells and adherent cells with good
contrast.

Cell Detection Method 2—This algorithm is ideal for detecting cell samples when
contrast is low, cells are clumped, or cells are at the edge of the well.

Cell Detection Method 3—This algorithm is ideal for detecting colonies and
distinguishing them from any artifacts around the edges of the colonies.

Very Low Contrast

5. After you set the process properties, to enter the process, click Start. See Select Source
on page 28.
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Select Source

The first step of the ImageMicroplate process is called Select Source. The sources you select
aremicroplate wells. Wells selected for imaging aremarked red, and those not selected for
imaging aremarked light blue.

Figure 4-2: Select Source screen for selecting wells
To select source wells:

1. If you want to change the plate type, select your newmicroplate type from the list
menu.

2. Select wells. By default, all of the wells are selected.

To select or deselect individual wells, left click on a well.

To select or deselect groups of wells, right-click and drag over the wells.

To deselect all wells, click Deselect All.

To select all wells, click Select All.

To select wells using a well list file, click Import, and then select your file containing
your list of wells to image.

Tip: For the format of the file, seeWell List File Format on page 107.

3. If you want to change the Scan Options:

In the Scan Type list menu, change your selection using the list menu.

If needed, change the Review Focus check box setting.

4. Do one of the following to continue:

To go to the next step, click Next. See Load Plate on page 29.

To exit the process and return to the ImageMicroplate process properties screen,
click Cancel. See Set Properties on page 26.
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Load Plate

The plate carrier automatically ejects and you are prompted to load themicroplate.

Figure 4-3: Load Plate screen
To load a microplate:

1. When the plate carrier ejects, place your microplate on the carrier with the A1well in the
back right corner.

2. Do one of the following to continue:

To go to the next step, click Next. See Focus on page 30.

To exit the process and return to the ImageMicroplate process properties screen,
click Cancel. See Set Properties on page 26.



CloneSelect Imager User Guide

30 5057146 C

Focus

Use the Focus step to optimize the image view before the scan.
On this screen, you can do the following:

Adjust Image Brightness on page 30

Adjust Image Focus on page 31

Save Image on page 31

Change Processing Type on page 32

Generate Confluence on page 32

Continue to the Next Step on page 32

Figure 4-4: Focus screen

Adjust Image Brightness

The software automatically determines the optimal brightness setting for imaging, but you
can manually adjust the Brightness setting.
To adjust image brightness:

1. Move the Brightness slider to the percentage value you want to use.

2. To update the image view using your new setting, click Grab.

Tip: Saturated pixels appear in red. Avoid making your image too bright.

3. Repeat steps 1 and 2 as needed.
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Adjust Image Focus

The system stores the last focus setting used for each plate type. After imaging a plate type
for the first time, the need for additional focus adjustments should beminimal.
Auto Focus
To adjust image focus:

1. Click Auto Focus.

2. To update the image view using your new focus setting, click Grab.
The changed focus setting becomes the default focus setting for the plate type in this
process run.

Tip: If there is debris on the bottom of the plate or on the glass plate carrier, the auto
focus might focus on these instead of the cells, which requires manually focusing.

Manual Focus
To manually focus on the image:

1. In the Focus section of controls on the right side of the screen, click the up or down
arrows to change the focus value, or type a new value in the field.

2. If needed, move the Zoom slider to look closer or farther at the image.
As you change the zoom level, the scale bar in the lower left of the image window
automatically adjusts.

Tip: When the zoom setting figure on the right of the slider is black, the system is
zooming optically. When the figure turns red, the system is zooming digitally and
you might see some pixelation of the image.

3. If needed, select a different well to focus on from the Change Well list menu.

Tip: By default focusing is done on well A1, or if A1 is not being imaged, focusing is
done on the first well of the plate to be imaged.

4. To update the image view using your new focus settings, click Grab.
The changed focus setting becomes the default focus setting for the plate type in this
process run.

Save Image

Images can be saved in bmp, jpg or png format.
To save the current image used for focusing:

1. Click Save Image.

2. In the Save File dialog, type and name and click Save.
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Change Processing Type

If needed, you can change the Processing Type you set in properties. See Set Properties on
page 26.
To change, in the Processing Type list menu, select a new cell and colony detection
processing type.

Generate Confluence

When enabled, all of the objects within the well get identified and highlighted in green.
To enable, select theGenerate Confluence check box.

Continue to the Next Step
To go to the next step, click Next. See Alignment on page 32.
To exit the process and return to the ImageMicroplate process properties screen, click
Cancel. See Set Properties on page 26.

Alignment

Use the Alignment screen to check that the camera aligns properly with the wells of the
microplate. Four images are taken over the north, south, east and west edges of well A1. The
well edges should align with themiddle of the box formed by the four red lines.

Figure 4-5: Alignment screen
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To align the camera:

1. If the well edges do not fall in themiddle of the box formed by the four red lines on
screen, click and drag on the lines to correct the alignment.

2. If needed, you can also adjust the image brightness by moving the Brightness slider to
the percentage value you want to use.

Note: Brightness changes only for the alignment image.

3. When the button is pink, click Re-image to recheck the alignment.

Continue to the Next Step
To go to the next step, click Next. See Imaging on page 33.
To exit the process and return to the ImageMicroplate process properties screen, click
Cancel. See Set Properties on page 26.

Imaging

Imaging starts automatically.

Note: When the Imaging process finishes, you automatically go to the Results screen
step.

The Imaging screen step includes the following tabs:

Confluence Tab on page 34

View Image Tab on page 35
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Figure 4-6: Imaging progress screen

Confluence Tab

Imaging runs in the Confluence tab and you can watch the process progress in a plate view.
A schematic of the plate appears with the image frames superimposed in light blue. As
images are captured and processed, the well frame changes color, light brown then to green.
After a frame changes to green, you can click on it, and view the image in the View Image
tab.
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View Image Tab

Figure 4-7: View Image screen
To view a frame image:

1. In the Confluence tab, after a frame changes to green, click on it.

2. In the View Image tab screen (Figure 4-7), you can use the following controls:

Well Schematic—Shows you which part of the well you are viewing.

Show confluence overlay—Click the check box to toggle off or on the green overlay.

Change well view—Click on the well name list menu to select a different well to view.

Export Image—Click to save the current image in bmp, jpg or png format. The
overlay is not saved with the image.

Zoom—Move the Zoom slider to look closer or farther at the image.
As you change the zoom level, the Scale Bar in the lower left of the image window
automatically adjusts.

Tip: The figure turns red when there is distorting image pixelation.

3. To return to the plate view, click the Confluence tab.

Continue to the Next Step
When the Imaging process finishes, you automatically go to the Results screen step. See
Results on page 36.
To exit the process and return to the Image Microplate process properties screen, click
Cancel. See Set Properties on page 26.
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Results

After an Imaging process completes, by default the Results screen for the Image Microplate
process opens in the Confluence tab. The Plate Type, Barcode and Processing Type appear
at the top of the screen for reference.
The Results screen for the Image Microplate process includes the following tabs:

Confluence—Shows the confluence level for each well, both graphically and as a list. Also
see Confluence on page 45.

View Image—Shows the image for a selected well. Also see View Image on page 48.
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Cell Number—Shows the estimated number of cells in each well, both graphically and as
a list. Also see Cell Number on page 49.

Plate Thumbnails—Shows the confluence area for each well. Also see Plate Thumbnails
on page 68.

Tip: You can use these tabs and more for reviewing and analyzing the results in the
Review Results process. See Review Results on page 40.

Continue to the Next Step
To continue to the next step, click Next. See Remove Plate on page 38.
To exit the process and return to the ImageMicroplate process properties screen, click
Cancel. See Set Properties on page 26.
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Remove Plate

In the Remove Plate screen step, the plate carrier automatically ejects, and you are
prompted to remove themicroplate from the plate carrier. You can choose to either repeat
the imaging process with another plate, or continue to the end of the process.

Figure 4-8: Remove Plate prompt screen

Image Another Plate

To image another plate:

If you want to image another plate, click Image Another Plate.
The plate carrier remains in the ejected position, and the Select Source screen appears
for you to continue. See Select Source on page 28.

Continue to the Next Step
To continue to the next step, click Next. The plate carrier retracts, and the Finish screen
appears. See Finish on page 39.
To exit the process and return to the ImageMicroplate process properties screen, click
Cancel. See Set Properties on page 26.
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Finish

When the Image Microplate process ends, the Finish screen appears.

Figure 4-9: Image Microplate process Finish screen
To close the screen, click Finish. You return to the Image Microplate process Summary
screen.

Figure 4-10: Image Microplate process properties Summary screen
In the Image Microplate process Summary screen, you can use the shortcut menu on the
right side of the screen to do any of the following Current Process tasks:

Save process—Saves the current process to the Recent Processes tab for future access.

Save process as template—Saves the current process to the Template tab for future
access.

Note: A saved template cannot be changed.

Close Process—Closes the process and returns you to theNavigation screen. See
Navigation Screen on page 21.
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Review Results
The Review Results process lets you review previous imaging runs to be reviewed and also
to do further data processing, such as confluence, monitor cell growth, cell number
estimation, monoclonality analysis and migration assay analysis.

Tip: After an Image Microplate process completes, the results automatically appear in
a Results process screen. See Results on page 36. That screen includes a subset of the
functionality that can be done using the Review Results process.

To review results:

1. From theNavigation screen, click on Review Results to start the process.

2. From the Review Results properties screen, click Start.

Figure 4-11: Review Results start screen

3. Continue in the Load Results screen. See Load Results on page 41.
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Load Results

The default location where imaging results are stored is the C:\Image Archive folder. All the
image and data files for each individual run are stored in a folder named with the date and
time stamp for the run, for example 2016-11-01T11-52-10. Within the Image Archive folder,
the run folders are automatically organized into separate folders for each month, for
example 2016-10.
The Review Results process, starts in the Results Archive tab, in the Runs list. Plates imaged
on the system appear in a list.

Tip: If free space on the disk is running low, the bar at the top of the window appears
orange and a warning is displayed in the top right corner. If disk space is getting
critically low the bar is colored red.

Figure 4-12: Review Results Runs screen
To load results:

In the Results Archive list, double-click on the run date you want to view.

Tip: To select multiple plates in the list, use the <SHIFT> and <CTRL> keys.
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Alternatively, you can use the following menu options on the right side of the screen:

Manage Results—SeeManage Results on page 42.

Results Selection > Results Location—When you save results data to a location
other than the default C:\Image Archive folder location, click to select from that
alternate location.

Other Applications > Migration—(Optional) You must purchase a license for this
softwaremodule. SeeMigration Analysis on page 77.

Manage Results

The right side of the Review Results process screen includes theManage Resultsmenu. In
this menu you can do the following tasks:

View on page 42

Export on page 43

Archive on page 43

Delete on page 43

Rename on page 44

Figure 4-13: Review Results screen

View
This is a another way to view from the Results Archive list.

Select a run date from the Results Archive list, and then click View.
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Export
Opens an export wizard dialog. Using the wizard you can select the results data you want to
export.

Figure 4-14: Data Export wizard dialog

Archive
Lets you archive to a network drive or disk of your choice the results data stored in the
default C:\Image Archive folder location.

Figure 4-15: Archive screen

Delete
Deletes all the images and results for the selected data set.
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Rename
Lets you rename the Barcode identification information.

Tip: To do Growth Rate analysis, this information must be the same for multiple runs.

To rename a run in the list:

1. Select a run date from the Results Archive list, and then click Rename.

2. In the Barcode field, type new identification information, and then press ENTER.

Analyzing Results

When you load results, by default the Results screen for the Review Results process opens
in the Confluence tab. The Plate Type, Barcode and Processing Type appear at the top of
the screen for reference.
The Results screen for the Review Results process includes the following tabs:

Confluence on page 45

View Image on page 48

Cell Number on page 49

Loci Count on page 52

Plate Thumbnails on page 68

Growth Rate on page 70

Summary on page 75

Figure 4-16: Results screen for the Review Results process
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Confluence

The Confluence tab displays the confluence level for each well, both graphically and as a list.

Figure 4-17: Confluence tab screen

Plate Confluence Overview
Each well is represented by a pie chart of the confluence level for that well. The pie charts are
color-coded such that low confluence is green and high confluence is red with shades in
between representing the intermediate levels.
To see the percentage of confluence for all the wells in the plate, hover the cursor over the
pie chart area. Confluence lower than 5% appears as <5 and confluence above 80% appears
as >80.
To see coordinates and confluence for an individual well, hover the cursor over a single well.
To see an image of a well in the View Image tab, click on a well. See View Image on page 48.
To copy the the overview to the clipboard, hover the cursor over a well, right-click, and then
click Copy to clipboard.

Confluence Distribution
The bar chart at the top right of the window shows the number of wells with a given
confluence level.
Dual Gates
The arrows pointing down at the top of the bar chart can be dragged across the chart. As
both lower and upper arrows are dragged, the corresponding confluence data appears. Any
wells that do not fall inside these lower and upper gates will be grayed out. The text shown
below the chart updates to give the number of wells that fall within the selected confluence.
For example, 10 out of 36wells selected for analysis have a confluence of between xx % and
xx %.
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Show Cumulative
When you select Show Cumulative, the individual bars in the chart merge to show the
confluence as continuous data.

Well Confluence
The confluence for each well appears in theWell Confluence list on the right.
Print
The Print option prints a schematic presentation of the confluence overview in the plate
format. The confluence values appear within the wells and the plate details appear at the top
of the overview.

Figure 4-18: Print schematic presentation of the confluence overview
To print the list, click Print.
Export
The Export option lets you save the well confluence list as a Comma Separated Values
(CSV), Excel, or XML file.
TheData Exportwizard guides you through the process of exporting the Confluence data.
Cell Number and Loci Count data can also be exported.
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Figure 4-19: Data Export wizard dialog
The wizard provides the option to export the data for the following time points:

The currently selected time

Themost recent time for each well plate

The complete time series.

Annotation
By default the Annotation field shows the number of wells that have been imaged. You can
edit this to enter somemoremeaningful annotation.

Note: This cannot be changed when viewing the data through a remote data viewer.

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.
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View Image

The View Image tab displays the images for a selected well. The whole well is displayed.

Figure 4-20: View Image tab screen

Well Schematic
By clicking on the image of the well currently being displayed, you can navigate to different
areas of the well and see where you are in the well in the image schematic on the right. The
confluence levels of the currently selected whole well are displayed below the schematic.

Imaging Tools
The following controls are available in the Imaging Tools section:

Zoom—Move the slide either left or right to zoom out or in. The lowest magnification of
the image is 18x and the highest is 144x. The figure turns red when there is distorting
image pixelation. When zoomed into an image, the zoomed area will be displayed on the
image thumbnail to the right.

Contrast—Move the slider either left or right to improve the image contrast.

Show Confluence—Select to turn the overlay on or off. The area of the image outside
the well is overlaid in red and the regions of the well where colony growth is detected are
overlaid in green.
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Well Information
Well Information includes the following:

Well Name—Use the drop down menu or the arrows to select a different well.

Well Confluence—Shows the well confluence percentage for the selected well.

Focus Position—Shows the focus point of the image when captured.

Brightness—Shows as a percentage the brightness level used to capture the imaged.

Export Image
The Export Image option lets you save the currently displayed image in .bmp, .jpg or .png
format. If Show Confluence is selected, the confluence overlay is displayed with the
exported image. The zoomed position is saved within the image.

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.

Cell Number

The Cell Number tab displays the estimated number of cells in each well, both graphically
and as a list. The number of cells is estimated using a formula that can be created for each of
your cell types from the confluence readings of a standard plate containing known numbers
of cells. See Setting up Cell Number Estimation on page 109 for a detailed procedure.

Figure 4-21: The cell number view
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Each well contains a colored fill with the estimated cell number indicated by the color and
size of the fill area, with a large red fill area representing a high cell number and a small blue
fill area representing a low cell number. A color scale is shown to the left of the graphic.
Hovering the cursor over a well displays a tool tip giving the well coordinate and the
estimated cell number for that well.

Select Cell Number Formula
Use the Select Cell Number Formulamenu to select from the created formulas for
estimating the number of cells per well.
In the Select Cell Number Formula section, you can also do the following:

Remove—Click Remove to delete the currently selected cell number formula from the
menu list.

Edit—Click Edit to change the currently selected cell number formula. See Edit on page
50.

Create New—Click Create New to create a new cell number estimation formula. See
Create New on page 50.

Edit
A graph displays the cell number against confluence for the formula.

Figure 4-22: Edit Cell Number Formula screen
To edit, drag the handles at each end of the line. The formula is appears at the top left and
the edited version appears immediately below it.
To automatically generate a best fitting line, click Regenerate Best Fit.
To change the formula name, in the Formula Name field, type a new name.
To cancel the edits and return to the Cell Number tab, click Discard.
To keep the edits and return to the Cell Number tab, click Save.
Create New
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Ensure that the confluence results displayed in the Confluence tab are those for a standard
plate containing known numbers of cells. The software automatically selects up to twelve
wells with confluence values ranging between 10% and 80% and displays them at the bottom
of the graph.
A screen to create a new cell number estimation formula appears. Ensure that the confluence
results displayed in the Confluence tab are those for a standard plate containing known
numbers of cells. The software automatically selects up to twelve wells with confluence
values ranging between 10% and 80% and displays them on the left of the graph.

Figure 4-23: Create New Cell Number Formula screen
To name your formula, in the Formula Name field, type your formula name.
Enter the cell numbers for each well into the corresponding well number box to the left of the
graph. After you enter all the relevant information, click Generate.
To cancel the edits and return to the Cell Number tab, click Discard.
To keep the edits and return to the Cell Number tab, click Save.

Well Cell Number
A list of estimated cell numbers for each well appears in theWell Cell Number list on the
right.
To change the well name, in theName column of the list, click the well name, pause, then
click the well name again. When the edit field appears, type a new name.

Export
The Export option lets you save the well cell number list as a Comma Separated Values
(CSV), Excel, or XML file.
TheData Exportwizard guides you through the process of exporting the Cell Number data.
Confluence and Loci Count data can also be exported.
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Figure 4-24: Data Export wizard dialog

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.

Loci Count

For colony formation assays, use Loci Count to count the number and size (area) of colonies
in each well.
Generated images can be processed using Loci Count. This detects and counts the number
of loci of growth, for example, cell colonies for applications including monoclonality
verification and colony forming assays. SeeMonoclonality Workflow on page 57 and Colony
Forming Assay Data Workflow on page 60. If a plate is imaged multiple times during colony
growth, the history of each well with one identified colony can be viewed for visual proof that
the colony is derived from a single cell progenitor.
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Plate View
In the Loci Count tab, the plate view displays each well with a figure indicating the number of
cell colonies found in the well. The default plate view displays the Loci Count (in theDisplay
Statistic section menu), however this can be changed toMean Loci Area, which displays this
value within each of the wells.

Figure 4-25: Loci Count in Plate View

Criteria
The Criteria section includes the following bar charts:

Minimum Area—The loci count (frequency) is plotted against the loci area (μm2) in a log
scale. The bar chart has two, lower and upper, gates that can bemoved accordingly to
eliminate unwanted objects/debris within the well that artificially inflate the number of
loci.

Minimum Compactness—The loci count (frequency) is plotted against the loci
compactness. The bar chart has two, lower and upper, gates that can bemoved
accordingly to eliminate irregularly shaped objects from the loci count. Compactness is
the relation between the area and the perimeter, expressed as a ratio of the actual area
and that of a perfect circle with the same perimeter.
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Well Data
In the Plate ViewWell Data section, you can click on a well to view the image. You can also
select well check boxes to save as a well list.
To save the selected wells in the list, click Save Well List. This file can be saved as a .csv file.
The file includes the plate barcode, run date, operator and the selected wells.

Display Statistics
TheDisplay Statisticsmenu lets you select to view as the overview either Loci Count or
Mean Loci Area.
To clear all of the current loci data processing, click Clear Loci.
Export
The Export option lets you save the wells and the corresponding Loci Count list as a Comma
Separated Values (CSV), Excel, or XML file.
TheData Exportwizard guides you through the process of exporting the Loci Count data.
Confluence and Cell Number data can also be exported.

Figure 4-26: Data Export wizard dialog
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The Loci Count criteria automatically populate from the gatedMinimum Area and
Minimum Compactness graphs. You can also export the following:

Histogram Bins—This option is used if the Colony area distribution box is selected. This
value sets the number of equi-sized bins for exporting loci frequency counts. The default
value is set to 20 bins.

Colony area distribution—When this box is selected, the colony area distribution data is
divided into the number of bins specified in theHistogram Bins and displayed with any
other exported data.

Note: Only wells selected in theWell Data list export.

Colony area and compactness for all colonies—When this box is selected, a list of all
colonies in all wells with the area and compactness for each colony expiorts.

Note: There is no filtering, so all the data is listed.

Well View
Clicking on the well of interest in the plate view of the Loci Count tab displays the image for
the well with an overlay over areas of growth detected according to theMinimum Area and
Minimum Compactness criteria.

Figure 4-27: The Well View in Loci Number
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If themicroplate has been imaged at several time points a film strip of schematics of the well
at the various time points appears across the bottom of the screen with loci colored in green.
This provides a way of checking if a colony results from a single cell or from more than one
cell.
To view the well image at that time point with the loci from the latest image outlined, click on
any of the schematics thumbnails.
To save the sequence of images, right-click on the sequence, and select Export image
sequence.The sequence can be saved as a .bmp, .jpg or .png file. The file includes the
confluence percentage and time and day the image was acquired.
To print a monoclonality report, see Report Generator on page 63.

Well Data
In theWell ViewWell Data section, to see if a colony is monoclonal, click on a well in the list.
Move through the list and mark wells as monoclonal in the following ways:

Click Yes button to mark a well as monoclonal and scroll to the next well image. Click No
to scroll to the next well without marking the well as monoclonal.

Click on a well to view its image and click on the check box to mark it as monoclonal.

Use the keyboard up and down arrow keys to scroll through the wells and the spacebar
to mark the wells.

To save the selected wells in the list, click Save Well List. This file can be saved as a .csv file.
The file includes the plate barcode, run date, operator and the selected wells.

Imaging Tools
The following controls are available in the Imaging Tools section:

Zoom—Move the slide either left or right to zoom out or in respectively. The lowest
magnification of the image is 18x and the highest is 144x. When the figure turns red the
system is zooming digitally and can cause some pixelation of the image. When zoomed
into an image, the zoomed area will be displayed on the image thumbnail to the right.

Contrast—Move the slider either left or right to improve the image contrast.

Highlight Features—Select to mark features with different overlay colors.

Return To Plate View—Click to return to the plate viewwithin the Loci Count tab to view
other wells. See Plate View on page 53.

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.
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Monoclonality Workflow
To run the Loci Count process for a monoclonal dataset:

1. After imaging the plate of interest at several time points, open the latest data point in
Review Results. The software automatically opens the data in the Confluence tab.

2. Click Plate Thumbnails to display all the imaged wells, and then to save processing time,
exclude wells without at least 1 colony within the well. See Plate Thumbnails on page 68.

3. Click Loci Count and adjust the well diameter as needed. See Loci Count on page 52.

4. Click Process to produce the loci counts for the selected wells. The Loci Count tab screen
changes to display an overview of all the selected wells and their corresponding loci
count.
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5. Click on one of the wells to display the well image. The image shows the loci processing.

6. Move theMinimum Area andMinimum Compactness lower and uppers sliders on the
graphs to gate out any unwanted debris and misshaped colonies within the wells. Adjust
to show only wells with 1 or 0 colonies.
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7. Click on Return To Plate View and check through some of the other wells to make sure
all debris and misshapen colonies are excluded. The plate overview reflects the
processing and displays the new loci count number in each of the wells.

8. Click through each well in theWell Data list. The well image appears and monoclonality
can be determined by looking back through the series of well images and identifying if
the colony originated from a single cell.
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9. If the colony did originate from a single cell, select the well by either selecting the check
box or clicking Yes.

CAUTION! Do not change the wellName. This can cause report errors.

After all the wells have been selected, the list of selected wells containing a monoclonal
colony can be saved and printed for further use.
To print a monoclonality report see Report Generator on page 63.

Colony Forming Assay Data Workflow
Analyzing colony forming assay data sets are very similar to gating monoclonality data,
however the data export can bemore detailed.

1. After imaging the plate of interest at several time points, open the latest data point in
Review Results. The software automatically opens the data in the Confluence tab.

2. Click Thumbnails to display all the imaged wells, and then to save processing time,
exclude wells without at least 1 colony within the well. See Plate Thumbnails on page 68.

3. Click Loci Count and adjust the well diameter as needed. See Loci Count on page 52.
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4. Click Process to produce the loci counts for the selected wells. The Loci Count tab screen
changes to display an overview of all the selected wells and their corresponding loci
count.

5. Move theMinimum Area and Minimum Compactness lower and uppers sliders on the
graphs to gate out any unwanted debris and misshaped colonies within the wells.

6. When satisfied with the gating of the data and the loci count produced, the data can be
exported. TheWell Data list is used for accepting wells based on monoclonality so it is
not necessary to select any of these wells. The data exports for all wells when exporting
the data via the wizard.

7. In theData Exportwizard, select Loci Count. The criteria automatically populate. The
default number of bins is 20, but in the example it has been changed to 5 bins. Select
Colony area distribution and Colony area and compactness for all colonies and then
click Next to finish exporting the data.
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8. Within the exported results produced, a summary of the experiment criteria appears in
the first rows the spreadsheet (top left).

9. When the Colony area distribution is selected, the following information is produced for
each well:

Name (if changed within the software)

Well number (eg A1)

Loci Count (this is the total)

Mean Loci Area

Bins equally splitting the loci area range into equal groups so that each identified loci
will fall into one of the corresponding groups based on its size. For example, out of
the 129 identified loci within well A1, 119 of these fall into the first bin with a loci area
range of 5589μm2 to 58498μm2.

When selecting the Colony area and compactness for all colonies, the area and
compactness of each identified loci is displayed:
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Report Generator

Note: Loci Count is included in CloneSelect Imager Software version 1.6 and newer,
but is an optional software license in CloneSelect Imager Software version 1.5. Contact
your Molecular Devices representative to purchase.

The Report Generator tab is an extension of the Loci Count functionality and as such is only
available when the Loci Count license for CloneSelect Imager Software version 1.6 or newer is
installed. Use these reports to provide evidence ofmonoclonality.

Note: If you see the following error message: “Report generation failed. Please
contact technical support for assistance.” make sure that the
DocumentAssemblerServiceSetup.exe is installed. Refer to the installation instructions
in the CloneSelect Imager Software Release Notes.

To generate a monocolonality report:

1. Follow the procedure in Monoclonality Workflow on page 57 to confirm the presence of
a single cell.

2. When the Loci Count tab plate view shows a matching colony number to that observed
in the Plate Thumbnail tab, preferably all ones and zeros, click the Report Generator
tab.

3. Select a monoclonal well of interest.
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4. In the timeline at the bottom of the window, select the 0.00 hrs time point.

5. In the upper right pane, under Cell Region, select the Select Cell Region check box to
activate the cell region marker, move the green selector-box over the cell image and then
click to apply themark. Only one cell region can bemarked and the green selector-box
size is not adjustable.
The image shown in the right side Cell Region pane appears in your report.

Tip: By default, the location of the first cell region remains fixed for all other time
points. To adjust the location of the cell region box, click on a different time point
thumbnail, select Select Cell Region, position the green box as needed, and click.
Click on other time points and repeat the adjustment process as needed

Tip: Deselect the Select Cell Region check box to end themarking process.
Alternatively, cell region marking is automatically ended when you go to mark
artifacts.

Tip: To remove the cell region mark, click Remove Cell Region.



Chapter 4: Running Processes

5057146 C 65

6. To mark artifacts in the well, under Artifact Region, select the Select Artifact Region
check box and then move the red selector-box over an artifact and click to apply the
mark. Continue to move and click the red selector-box to mark up to 10 artifacts in the
well. The selector-box size is not adjustable.
The images shown in the right side Artifact Region pane appear in your report.

Tip: If you zoom in close and want to scroll around the well image during the
artifact marking process, you must deselect the Select Artifact Region check box,
click and drag to move within the cell view and select the Select Artifact Region
check box again when you are ready to mark again.

Tip: To remove an artifact region, on the right in the Artifact Region pane, select
the artifact thumbnail that you want to remove and click Remove Selected.
To removemultiple artifact regions, press <CTRL> while selecting themultiple
artifact thumbnails, and then click Remove Selected.

7. When you are finished marking regions, click Save Regions.

Tip: The image Contrast setting is used in the generated report. If you batch
generate reports, the last image Contrast setting is used in all of the reports.

8. Click Return To Plate View to continue.

9. In the right side pane, in theWells With Cell Regions list, select theName check box of
the well of interest you marked with regions. Only wells with cell regions marked appear
in the right side pane list.

Tip: If you need reports for multiple wells of interest, select theName check box
for those too. Multiple well selections producemultiple reports with one well
detailed per report.
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10. Click Generate Report to open the report preparation screen.

11. In the report preparation screen you can adjust the following:

Header—Type the title used in your report in this field.

Notes—Type any additional information you need to include in your report in this
field.
If you are generating multiple reports, whatever is typed here appears in all the
reports.
To include symbols in your notes, use the drop-down list to select an available
symbol and click Insert.

Options—Select these check boxes as needed to determine how the content is
presented in the report. Available options include:

Highlight Feature—When selected this enables the highlighting of the colony in
your report.

Hide Region—When selected this excludes the cell and artifact region markings
on the whole well image from your report.

Include All Regions of Well—When selected this includes all images from the
well at single cell resolution.

Note: Generates a much longer report because all of the images are
exported.

Loci Count Plate View—When selected this includes the Loci Count Plate View in
your report including well details and criteria settings.

Output File Type—Enables you to select eitherWord Document output or PDF
Document output for your report.
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12. At the bottom of the screen, by default all of the time point thumbnails are selected to
be included in the report. If needed, to exclude a time point thumbnail from your report,
deselect the thumbnail check box.

13. To generate the report, click Create Report.

14. Specify where the report should be saved and click OK.

15. When the Report generation successmessage appears, click OK.

16. When finished, click Return to Plate View.

View Report
To view your report:
If you created aWord Document report, you must have aWord file format reader installed,
or someMicrosoft Word software installed, such as:

Windows 10 users—Microsoft Word Viewer or Microsoft Word 2016

Windows 7 users—Microsoft Word 2016

If you created a PDF Document report, you must have some PDF viewer software installed,
such as Adobe Acrobat Reader.
Go to the location you specified when you clicked Create Report and double-click the file
name.

Tip: By default theWord document output is read-only. To edit a Word document,
before opening the report, right-click on the file name, select Properties and deselect
Attributes > Read-only.
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Plate Thumbnails

The Plate Thumbnails tab shows the entire plate and the wells that have been imaged as
thumbnails. The thumbnails include the confluence overlay of each of the imaged wells. Use
this screen to select wells to be included or excluded from analysis, which helps to be focus
only on wells of interest. Any wells included or excluded in the Plate Thumbnails tab
automatically get included or excluded in the Confluence, Cell Number, Loci Count, and
Growth Rate tabs as well.

Figure 4-28: Plate Thumbnails tab screen

A group well selection highlights in yellow.

Excluded well selections highlight in red.

Included well selections highlight in green.

Figure 4-29: Group selected wells and excluded well with selection options menu
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To specify what to do with each well for your analysis, do the following:

1. Hover the cursor over a well of interest.

Tip: To select a group of wells, press and hold CTRL and then select multiple wells.
Release CTRLwhen you finish selecting.

2. Right-click on the well of interest, and then select one of the following from the options
menu:

Copy to Clipboard

Exclude selected from Process

Include selected in Process

Exclude all from Process

Include all in Process

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.
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Growth Rate

If a microplate has been imaged previously, growth curves appear for all the wells in the
plate. The system determines if the plate has been imaged by looking for the barcode in the
stored results, so use barcoded microplates to enable this function. Named plates can also
be used, but for the software to identify the series, the namemust be typed exactly the
same each time the plate is imaged. The ability to rename plates does risk the inclusion of
mis-named plates in the growth curve data.
The captured images for the selected well appear in the well schematic below the graph.
To see the well coordinate for a point, hover the cursor over a data point.

Figure 4-30: Growth Rate tab screen showing Data Points graph
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Figure 4-31: Growth Rate tab screen showing Averages graph

Display Mode
You can view the following growth rate graphs:

Data Points—graphs all the well data points

Averages—graphs the averages of the well data points.

The thick red line within both graphs shows the growth rate for the selected well.

Select Well
Use themenu or the arrows to select a different well.

Include TimePoints
Use the Include Timepoints list to select which time points get included or excluded from the
growth rate output. All plate scans with the same barcode are automatically selected for
inclusion in the growth rate data unless you deselect them here.
To change time point selections:

Adjust the time point selections, and then click Apply.

Growth Rates
TheGrowth Rates list displays theWell, Total Growth andMean Rate for each well in the
data set.
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Print
The Print option prints the growth curve graph.

Figure 4-32: Growth Curve Graph Print Preview

Export
The Export option lets you save all the data used to construct the growth curve as a Comma
Separated Values (CSV), Excel, or XML file.
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TheData Exportwizard guides you through the process of exporting the Confluence data.
Cell Number and Loci Count data can also be exported.

Figure 4-33: Data Export wizard dialog
The wizard provides the option to export the data for the following time points:

The currently selected time

Themost recent time for each well plate

The complete time series.
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Figure 4-34: Data Export wizard with excluded wells options
When the option Include, but export as zero value is selected, the excluded wells are listed
in the exported data with a zero value in the Cell Number column.

Figure 4-35: Example export data with Well A1 and Well A3 excluded

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.
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Summary

The Summary tab shows a summary of the confluence data, growth curve data and imaging
credentials.
The table lists theDate Imaged, Elapsed Time, Operator, Imaged on,Min Confluence,
Mean Confluence and Max Confluence for each time the plate was imaged.

Figure 4-36: Summary tab screen

HTML Report
TheHTML Report button lets you generate an HTML formatted report of the various
information relating to the data that you select, such as confluence, growth rate, and cell
number.
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To create an HTML report:

1. In the Review Results > Results > Summary tab, click HTML Report.

2. In theHTML Report Wizard dialog, select the information you want included in the
report.

Figure 4-37: HTML Report Wizard dialog

Note: The loci data are automatically populated using theMinimum and
Maximum Area and Minimum and Maximum Compactness data set in the Loci
Count tab. See Loci Count on page 52.

3. To save the report as an .html file, click Generate.

Cancel
If you click Cancel, you are prompted to confirm you want to end the process. Clicking Yes at
the prompt takes you to the Load Results screen. See Load Results on page 41.
To finish, see Finish on page 83.



Chapter 4: Running Processes

5057146 C 77

Migration Analysis

Note: (Optional) You must purchase a license for this softwaremodule.

Do Migration analysis on data that has been imaged over a number of time points.
To view the data for a migration assay:

In the Results Archive list, double-click on the run date you want to use, and then click
Migration.

Figure 4-38: Migration analysis Overview screen
TheMigration data analysis screen includes three tabs:

Overview on page 78

Thumbnails on page 79

Well Details on page 79

For each data set analyzed, the Plate Type, the Barcode, and the Processing Type
information appears at the top of the screen for reference.
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Overview

TheOverview tab provides an overview of themigration assay data. A heat map is generated
and can be displayed using one of three Filter Bymenu options:

Migration Rate—measures the rate of increase in cell movement (mm2 per hour) over
the entire time period.

Total Migration—measures the increase in area of cell movement (mm2) over the entire
time period.

Maximum Migration Rate—measures the largest rate of increase in cell movement
(mm2 per hour) between any two adjacent time points.

Figure 4-39: Migration analysis Overview screen
The table to the right of the heat map also displays these statistics for each well.
To reorder the data, click on any of the table headers.
To copy the heat map to the clipboard, right-click anywhere on themap and select Copy to
clipboard.
To highlight the well on the information table and on the Confluence (%) graph, click on any
well of interest.
To view a well in theWell Details tab, double-click on the well of interest.
Export
The Export option lets you save data for either Selected Time Points or for All Time points.
You can also export the confluence data if required.
TheData Exportwizard guides you through the process of exporting. The data can be
exported as a Comma Separated Values (CSV), Excel, or XML file.
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Thumbnails

The Thumbnails tab provides an overview of each well image with wound detection, where
no cells are detected.

Figure 4-40: Migration analysis Thumbnails screen
To copy the thumbnails to the clipboard, right-click anywhere on the thumbnail map and
select Copy to clipboard.
The following controls are available:

Zoom—Move the slide either left or right to zoom out or for the whole thumbnail map.

Time Points—Use the drop down menu or the arrows to select a different time point.

Note: If the time points available are restricted by the End Time Point option in
theDisplay Graph section of theWell Details tab, only the selected time points
appear here.

Start Animation—To observe themigration taking place in the wells, click this button to
animate the thumbnails from the starting time point to the final time point.

Note: If the time points available are restricted by the End Time Point option in
theDisplay Graph section of theWell Details tab, only the available time points
animate here.

Well Details

TheWell Details tab provides all the details generated from individual wells. Awhole well
image appears center screen with time point thumbnails in the film strip below.
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To display the enlarged image for a time point in the film strip below, click on any of the
thumbnails.
By defaultWell Details opens in theDisplay Image view. You can also view as a graph by
clicking Display Graph in the right side screen controls.

Figure 4-41: Migration analysis Well Details screen

Display Image
TheDisplay Image controls include the following:

Image Tools
Image Tools include the following:

Zoom—Move the slide either left or right to zoom out or in. The lowest
magnification of the image is 18x and the highest is 144x. When the figure turns red
the system is zooming digitally and can cause some pixelation of the image. When
zoomed into an image, the zoomed area will be displayed on the image thumbnail to
the right.

Contrast—Move the slider either left or right to improve the image contrast.

No Overlay—Select to hide all overlay highlights.

Overlay Cell Growth—Select to highlight in green all areas with cells.

Overlay Wound—Select to highlight in green all areas without cells.
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Well Information
Well Information include the following:

Well Name—Use the drop down menu or the arrows to select a different well.

Total Migration Area—Shows as a value themeasurement of the total cell growth in
mm2 over the entire time period for the selected well.

Focus Position—Shows the focus position used for themicroplate.

Brightness—Shows the brightness value used for imaging.

Export Image—Lets you save the currently displayed image in .bmp, .jpg, or .png
format.

Start Animation—To observe themigration taking place in the wells, click this button to
animate the thumbnails from the starting time point to the final time point.

Note: If the time points available are restricted by the End Time Point option in
theDisplay Graph section of theWell Details tab, only the available time points
animate here.

Display Graph
The Display Graph view shows the information gathered from the individual wells and
displays it in graph format. The graph appears center screen with Migration Area (mm2)
plotted against Time (hours). A time point thumbnail of the selected well, denoted by a red
line on the graph, appears below the graph. Each thumbnail image in the film strip displays
the total migration at that time point and time passed since the first time point in the series.
When hovering over a data point on the graph for the selected well (denoted by a red line on
the graph), the corresponding thumbnail will be highlighted in red.
To return to the image view, click Display Image in the right side screen controls.

Figure 4-42: Migration analysis Well Details Display Graph screen
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TheDisplay Graph controls include the following:

Wells
Wells include the following:

Selected Wells—Use the drop down menu or the arrows to select the well currently
displayed on the graph as a bold red line.

Plotted Wells—Use to select the wells for plotting on the graph. The selection and
deselection of these wells only apply to the graph and not the overview. Shows on a
mini platemap all of the wells that were imaged and are plotted on the graph. When
wells are selected they are yellow in the platemap. When wells are deselected they
are blue in the platemap.

End Time Point—Use the drop down menu or the arrows to select an end time point.
When the end time point is selected the graph shows only the time points before and
including the end point selected.

Note: When changing the End Time Point, only the selected time points appear
on the Thumbnails tab. Data on theOverview tab is also recalculated using the
selected time points.
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Finish

When you finish the Review Results process, you return to the Review Results process start
screen. See Review Results on page 40.
To finish the Review Results process from a results tab:

1. In any review results tab, click Cancel. See Analyzing Results on page 44.

2. In the Load Results screen, click Cancel. See Load Results on page 41.

3. In the Finish screen, click Finish.

Figure 4-43: Review Results process Finish screen

Moving Images

You can move acquired images from the local system computer. The default location to
which imaging results save is c:\Image archive\. For more imaging results details, see Load
Results on page 41.
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Batch Microplate Imaging
Batch Microplate Imaging enables you to imagemultiple plates with the same configuration
without reviewing the focus and alignment between plates.
To enter a Batch Microplate Imaging process, in the Navigation screen, click Batch
Microplate Imaging. See Navigation Screen on page 21.

Figure 4-44: Batch Microplate Imaging Summary screen
To set the properties for the Batch Microplate Imaging process, the process screen opens in
the Process Properties screen in the Summary view. Change the screen view, as needed, and
change properties as needed. See Process Properties Screen on page 24. Alternatively, you
can click the Setup header, and then select from the available properties.
The Auto brightness all Plates option automatically selects the appropriate brightness for
the image.
This process automatically looks for barcodes on plates, but if not detected, you are
prompted to manually enter a plate barcode or plate name.
To begin the process, click Start. The first step of the Batch Microplate Imaging process is
called Select Source.This and the remaining process steps are the same as the Image
Microplate process. See ImageMicroplate on page 25.
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E-Scope
The E-Scope process lets you view cells at a high resolution (1.85 µm)without performing any
image analysis. Images are not saved.
Frames to be imaged can be freely selected by clicking with themouse on the screen.
To enter an E-Scope process, in the Navigation screen, click E-Scope. See Navigation Screen
on page 21.

How to Image Using E-Scope

Note: Images are not saved.

To image using E-Scope:

1. To set up the properties screen, click the Source header, and then select from the
available plates.

Figure 4-45: E-Scope Summary screen

2. To begin the process, click Start.

3. When the plate carrier ejects, place your microplate on the carrier with the A1well in the
back right corner, and then click Next to Load Plate.
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4. Use the Alignment screen to check that the camera aligns properly with the wells of the
microplate. Four images are taken over the north, south, east and west edges of well A1.
The well edges should align with themiddle of the box formed by the four red lines.
Adjust as needed.

If the well edges do not fall in themiddle of the box formed by the four red lines on
screen, click and drag on the lines to correct the alignment.

If needed, you can also adjust the image brightness by moving the Brightness slider
to the percentage value you want to use.

Note: Brightness changes only for the alignment image.

When the button is pink, click Re-image to recheck the alignment.

To finish Alignment and continue, click Next.

5. In the Select Location screen, in the displayed schematic of themicroplate, to view a
real-time image, click on one of the available image frames.

Figure 4-46: E-Scope Select Location screen
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6. The View screen opens automatically with the selected image frame.

Figure 4-47: E-Scope View screen
You can do any of the following in the View screen:

Brightness—Move the slider either left or right to improve the image brightness.

Focus—Click the up or down arrows to change the focus value, or type a new value
in the field.

AutoFocus—Click to automatically adjust the image focus.

Zoom—Move the Zoom slider to look closer or farther at the image.
As you change the zoom level, the Scale Bar in the lower left of the image window
automatically adjusts.

Tip: The figure turns red when there is distorting image pixelation.

High Resolution—Select to use high resolution imaging (1.85 µm), deselect to use
standard resolution imaging (3.7 µm).

Grab—Click to apply the changes you madewhile viewing the image.

Save Image—Click to save the current image in bmp, jpg or png format.

7. To select another image or well, click Back to go back to the Select Location screen. See
step 5.

8. To continue, click Next.

9. When the plate carrier ejects, remove your plate, and then click Next.

10. In the Finish screen, click Finish to return to the E-Scope process start screen. See step 1.
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Eject Plate Carrier
The Eject Plate Carrier process is one of theMaintenance Processes on the Navigation
screen. See Navigation Screen on page 21. It enables a way to eject the plate carrier for
cleaning or if a microplate has been left in the instrument.
To eject the plate carrier:

1. To enter the Eject Plate Carrier process, in the Navigation screen, click Eject Plate
Carrier.

2. In the Eject Plate Carrier start screen, click Start.

3. Clean the plate carrier or remove a microplate.

4. To close the plate carrier and continue, click Next.

5. In the Finish screen, click Finish to return to the Eject Plate Carrier process start screen.
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Chapter 5: Health and Safety

Transport and Storage
The CloneSelect Imager must be:

Stored and transported in temperatures within the range –25°C to +55°C.

Transported with the original packing foam inserts in place to protect the objective and
objective holder.

Lifting Points
The CloneSelect Imager is intended for bench top operation. Care should be taken when
moving the CloneSelect Imager. It is recommended that 2 people lift it.

External Covers

WARNING! If any of the external covers on the CloneSelect Imager are removed
the power supply is not automatically interrupted. If it is necessary to remove
any of the external covers you must ensure that the power is switched off first
and do not attempt to use the robot until the covers are replaced.

Electrical Safety

WARNING! HIGH VOLTAGE. The CloneSelect Imager must be connected to a
properly earthed power outlet to protect users from the risk of electric shock. The
main chassis of the machine is earthed together with all associated electrical
components. Do not remove any of the fixed covers, as there are no user
serviceable parts inside. All internal work should be referred to Molecular Devices
approved service personnel.

Drive Safety

WARNING! PINCH HAZARD. There is a potential pinch hazard with the drive
mechanism. Please ensure that you do not attempt to load the plate until the
drive has fully extended.

Noise levels
During normal operation the level of airborne noise emitted by the robot will not exceed
70 db measured at 1meter.
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Chapter 6: Maintenance

Do only themaintenance described in this guide. Maintenance procedures other than those
specified in this guidemust be done by qualified Molecular Devices personnel only. See
Obtaining Support on page 101.
Maintenance procedures that you can do to ensure optimal operation of the instrument
include:

Doing PreventiveMaintenance

Cleaning the Instrument on page 92

WARNING! Service or maintenance procedures other than those specified in this
guide can be done only by Molecular Devices qualified personnel. When service is
required, contact Molecular Devices Technical Support.

Doing Preventive Maintenance
You are responsible for doing daily and weekly maintenance. Also, Molecular Devices
strongly recommends that a complete instrument preventativemaintenance service be
done annually by Molecular Devices.

General Precautions

All wastemust be disposed of according to local regulations.

WARNING! Do not use in explosive environments.

Daily Maintenance

Keep the CloneSelect Imager instrument dirt-free and dust-free.

Clean the top and bottom of the removable glass plate holder using a lint-free cloth
sprayed with 80% ethanol.

Weekly Maintenance

Check operation of equipment.

Check for damage.

Annually Maintenance
A complete instrument maintenance should be done annually by an approved service
engineer. To obtain a maintenance contract or schedule a service visit, contact your
Molecular Devices representative or technical support www.moleculardevices.com/service-
support.

6
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Cleaning the Instrument
Clean the instrument using 80% ethanol or dilute detergent and a lint-free cloth.

CAUTION! Do not use organic solvents and abrasive cleaners because they can
damage the cover.

Apply cleaning solution using a suitable lint-free cloth.

CAUTION! Do not pour cleaning solution directly on to the instrument or other
objects.

Upgrading Software

Note: Molecular Devices is responsible for installing the CloneSelect Imager Software
during your initial instrument installation and configuration.

The CloneSelect Imager Software controls the CloneSelect Imager instrument and is based
around the concept of the instrument running processes.
The following procedures are also located in the Software Release Notes. The following
procedures are required to upgrade the CloneSelect Imager Software:

Computer System Requirements

Backing Up the Configuration File on page 93

Uninstalling the Current the Software on page 94

Installing Microsoft .Net 4.5.2 on page 94

Installing the CloneSelect Imager Software Upgrade on page 95

Obtaining a License for the Software on page 95

Computer System Requirements

The CloneSelect Imager Software requires the following computer specifications:

Item Description

Operating system Windows 10, 64-bit
Windows 7, 32-bit (x86) minimum

Memory 4 GB RAMminimum

Data Connection 10/100 Ethernet port

Camera Connection Basler Pylon: USB 3.0 port

Table 6-1: Computer System Requirements



Chapter 6: Maintenance

5057146 C 93

CAUTION! Do not replace or upgrade the computer operating the system. The
computer supplied with your system includes hardware and driver components
specifically configured to control your CloneSelect Imager instrument.

Backing Up the Configuration File

Before removing the previous installation of the software, you must back up the
configuration in case you need to reinstall it later.
The recommended process is two steps:

1. Add aWindows System Restore Point on page 93

2. Back up CloneSelect Imager Software on page 94

Add a Windows System Restore Point

If you are using theWindows 7 operating system, do the following:

1. Click Start > Control Panel> System and Security, and then click the System link.
From the Startmenu, you can also get to the System screen by typing SYSTEM in the
Search field, and then click System from the results list.

2. In the left panel, click the System Protection link.

3. In the System Properties dialog, click the System Protection tab and then click Create.

4. In the Create a Restore Point dialog, choose a name that you will remember, such as the
current date or the name of a program you are about to install.

5. When themessage The restore point was created successfully appears, click Close.

6. In any other related open dialogs, click Close to finish.

If you are using theWindows 10 operating system, do the following:

1. In the Start search field, type CREATE A RESTORE POINT, and select Control panel.

2. In the System Properties dialog, in the System Protection tab, select themain system
drive, and click Create.
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3. Type a description to identify the restore point.

4. Click Create.

5. When themessage The restore point was created successfully appears, click Close.

6. In any other related open dialogs, click Close to finish.

Back up CloneSelect Imager Software

To back up your current configuration:

1. Click Start > All Programs > Molecular Devices > CloneSelect > Configuration Manager.

2. In the Fusion Configuration Manager, click Backup To File.

3. In the Backup Fusion Configuration dialog, type the version number of the currently
installed software and the date and then click OK.

4. In the Save Configuration File dialog, locate and select the folder where you want to
save the backup file, type a File name, and then click Save.

Uninstalling the Current the Software

To uninstall the current software:

1. Click Start > Control Panel.

2. Under Programs, click Uninstall a program.

3. From the list of programs, click CloneSelect Imager.

4. Click Uninstall.

5. Follow the on-screen instructions to finish uninstalling the software.

Installing Microsoft .Net 4.5.2

Windows 10 computers should already haveMicrosoft .Net 4.6 or newer installed. If your
system has Microsoft .Net 4.5.2 or newer installed, skip the following procedure.
To install Microsoft .Net 4.5.2 software:

1. Download theMicrosoft .Net 4.5.2 software from theMicrosoft website.

2. Run the installer and follow the on-screen instructions to finish installing the software.

CAUTION! If you have a custom software configuration, contact Molecular Devices
Technical Support to determine if you can upgrade your software. See Obtaining
Support on page 101.
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Installing the CloneSelect Imager Software Upgrade

To install the software upgrade:

1. Download the upgrade installation files to the system computer.

2. Double click the CloneSelect Imager v.1.7.x.msi file to start the installation program.

3. Follow the on-screen instructions to finish installing the software upgrade.

4. Select Setup Type: Typical.

5. Contact Molecular Devices Technical Support for the upgrade license. See Obtaining
Support on page 101.

Obtaining a License for the Software

The first time that you start the your Molecular Devices software after completing the
installation, the software prompts you for a license.
Obtaining a software license is a two-part process involving the following:

Requesting a Software License on page 95

Installing a Software License on page 97

Requesting a Software License

To request a new software license:

1. In the licensemessage dialog, click Yes.

2. In the license request wizard, select Request a new license, and then click Next.
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3. Enter the requested information, and then click Next.

4. To save the request file to a location on your computer for attaching it to an email, click
Save.

5. In the Save the request to a file dialog, save the file in a location where you can easily
find it.

6. To close the wizard, click Finish.

7. Change the LicenseRequest.req file name to a LicenseRequest.txt file, and then email it
to Molecular Devices Technical Support. See www.moleculardevices.com/service-
support.

8. After you receive the license file, save it on the system computer where it is easily
accessible, and then install the license.

http://www.moleculardevices.com/service-support
http://www.moleculardevices.com/service-support
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Installing a Software License

After you receive your license from Molecular Devices Technical Support, do the following:
To install a software license:

1. From the computer desktop, double-click the CloneSelect Imager icon to start the
software.

2. In the Licensing dialog, select Install a license file and then click Next.
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3. Click Open.

4. In the Select the License File to install dialog, locate and select the license file you
previously saved, and then click Open.

5. After the license file automatically installs, click Finish.
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Chapter 7: Troubleshooting

This section explains how to resolve issues that you might experience when you work with
the CloneSelect Imager and software.

Troubleshooting Barcodes
If you are using barcodes and they are not detected correctly, try the following:

Rotate the plate 180 degrees.

Tip: The instrument scans from either the front or the back, but only one sensor
is active. Contact Molecular Devices Technical Support if you need to change the
scan direction on your instrument.

If one out of 10 plates fails to be read, then this might be a placement issue that can be
fixed with a small change in the plate configuration.

Add more white space at beginning or end.

Restrict numbers to a maximum of six (6) digits.

Verify that the codes meet the requirements. See Using Barcodes on page 18.

If detection is still a problem, contact Molecular Devices Technical Support
www.moleculardevices.com/service-support.

7

http://www.moleculardevices.com/service-support
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Troubleshooting Well Detection Area
If the detection area is outside the well, change the detection area by changing the plate
parameters.

To change the well detection area plate parameters:

1. In the software select Tools > Configuration.

2. When the warning appears, click Yes.

3. In the Edit Configuration dialog, select Consumables.

4. Expand theMicroplates tree.

5. Locate your plate and modify the following values as needed:

a. WellBottomDiameter changes the size of the red overlay. Decreasing this number
makes the outcut in the red overlay smaller.

b. A01 offset shifts the hole up, down, left, or right.

c. Pitch changes the distance between one well and the next, center to center.

d. To finish, click Close.

If detection area is still a problem, contact Molecular Devices Technical Support
www.moleculardevices.com/service-support.

http://www.moleculardevices.com/service-support
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Viewing and Generating an Error Report
When your instrument is in an error state, you can view and generate an error report. If you
need Molecular Devices Technical Support help, this report is required.
To generate an error report:

1. Select Tools > Configuration.

2. Select System Log.

3. From the System Log list, select themost recent Log.

4. From the Event Severity section, select theError and Fatal check boxes.

5. To review the details, highlight the results lines.

6. To generate a report of the results listed, select Tools > Prepare Error report.

7. When the Error Reporting Wizard dialog appears, click Next.

8. Specify a location to save the error logs.

9. When requested, send the generated file to Molecular Devices Technical Support .

Obtaining Support
Molecular Devices is a leading worldwidemanufacturer and distributor of analytical
instrumentation, software, and reagents. We are committed to the quality of our products
and to fully supporting our customers with the highest level of technical service.
Our Support website, www.moleculardevices.com/service-support, has a link to the
Knowledge Base, which contains technical notes, software upgrades, safety data sheets, and
other resources. If you still need assistance after consulting the Knowledge Base, you can
submit a request to Molecular Devices Technical Support.
Please have your instrument serial number or Work Order number, and your software
version number available when you call.

WARNING! BIOHAZARD. It is your responsibility to decontaminate
components of the instrument before you return parts to Molecular Devices for
repair. Molecular Devices does not accept items that have not been
decontaminated where it is applicable to do so. If parts are returned, they must be
enclosed in a sealed plastic bag stating that the contents are safe to handle and
are not contaminated.

http://www.moleculardevices.com/service-support


CloneSelect Imager User Guide

102 5057146 C



5057146 C 103

Appendix A: Technical Specifications

The following tables list the technical specifications for the CloneSelect Imager.

Item Description

Size 575 mm (width) x 720 mm (depth) x 438 mm
(height)
Excluding ancillary equipment

Weight 45 kg

Table A-1: Dimensions (Total assembled)

Item Description

Temperature 10°C to 40°C

Humidity 20% to 80% non-condensing

Altitude Up to 2000 M

Mains supply ± 10% Rated Voltage

Transient overvoltage Installation Category (Overvoltage category) II

Rated pollution Pollution degree 2

Table A-2: Operating Environment (Indoor use only)

Item Description

Voltage 100 to 200 VAC, 50 to 60 Hz, single phase

Power 100 VA

Connections IEC input

Fuses F1 - F3A

Table A-3: Electrical Supply

A
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Instrument Dimensions

Figure A-1: The front and top views of the instrument.

Figure A-2: The right side* and left side views of the instrument.

* The vertical measurement is from the top of the glass in the plate carrier to the top of the instrument

Note: All dimensions are in millimeters.
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Appendix B: Compatible Plate Types

The standard CloneSelect Imager is configured to use the following plate types:

Manufacturer Catalogue number Well format

Corning / Costar 3300, 3595, 3474 96

3524 24

3513 12

3516 6

Greiner 781182, 781091,781098 384

657185 6

Note: See the Knowledge Base for more plate compatibility information.
www.moleculardevices.com/service-support

B

http://www.moleculardevices.com/service-support
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Appendix C: Well List File Format

Note: You can only have oneWell List File per Plate Type.

Use the following format for yourWell List File:
Molecular Devices 96 well

A6

B5

E8

and so on.
To create aWell List File:

1. As the first line, enter the Plate Type name.

2. On a new line, enter the name of a well to image.

3. Repeat step 3 until all the wells you want to image are listed.

4. Save as a text file (.txt).

5. Use this file as your Import file during an ImageMicroplate process from the Select
Source screen. See Select Source on page 28.

C
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Appendix D: Setting up Cell Number Estimation

When creating a new cell number estimation formula you need to set up a standard plate
that has a known number of cells in a range of wells.
Make a dilution series of a cell suspension on which a cell count has been performed (e.g.
using trypan blue). Dispense an aliquot of each dilution into a well and incubate for a few
hours to allow the cells to attach. Then image the plate and follow the instructions to create
a new cell number estimation formula.

D
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Appendix E: CloneSelect Imager Data Viewer Software

Note: The CloneSelect Imager Data Viewer Software is optional. Contact Molecular
Devices Technical Support to purchasing.

The CloneSelect Imager Data Viewer Software enables you to view results generated by the
CloneSelect Imager instrument on a computer that is remote from the instrument.
You can either access a copy of the results files or you can access the folder on the
instrument computer using Windows folder-sharing if the two computers are networked
together. The default folder location is C:\Image archive.

Tip: Any time you install and use the CloneSelect Imager Software on a computer that
is detached from the instrument, it functions as a data viewer.

Software Prerequisites
The CloneSelect Imager Data Viewer Software requires the installation ofMicrosoft .NET™
Framework 4.5.2 or newer. Your computer might already have it installed.
To check for .NET Framework 4.5.2:

1. Go to the Control Panel and click Add/Remove Programs.

2. Look in the list forMicrosoft.Net 4.5.2 or newer.

Tip: Windows 10 computers should already haveMicrosoft .Net 4.6 or newer
installed.

3. IfMicrosoft .Net 4.6 or newer is installed, continue to Installing CloneSelect Imager Data
Viewer Software, otherwise install it now. See Installing Microsoft .Net 4.5.2 on page 94.

E
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Installing CloneSelect Imager Data Viewer Software
After verifying that the .NET Framework 3.5 SP1 is installed, you can install the CloneSelect
Imager Data Viewer Software. See Software Prerequisites.
To install the software:

1. Log in to theMolecular Devices Support website, go to the CloneSelect™ Imager System
Software Download Page, and in the table, click theDataViewer > Installer link.

2. Double-click CloneSelect Imager Data Viewer v.x.x.x, where x.x.x is the software version
number, to start the installation.
To start the installation, if you are using the Recovery DVD, double-click
Setup_CloneSelectImager_Viewer.exe.

3. Follow the on-screen instructions.

Licensing CloneSelect Imager Data Viewer Software
When the CloneSelect Imager Data Viewer Software is installed, you must license it.
The first time that you start the CloneSelect Imager Software after completing the
installation, the software prompts you for a license. See Obtaining a License for the Software
on page 95.

Using CloneSelect Imager Data Viewer Software
When the CloneSelect Imager Data Viewer Software starts, themain process screen appears.
To view the results, locate where they are stored. On the right side of the screen, click
Results Location and browse for the location of the results. The location can be a local folder
on the computer, a CD-ROM or DVD, or, if the two computers are networked together, it can
be a shared folder on the instrument computer.
After you select the location, the software catalogs all of the results and displays a list. You
can then view the results the sameway as you do on the instrument computer.

https://mdc.custhelp.com/app/answers/detail/a_id/20068
https://mdc.custhelp.com/app/answers/detail/a_id/20068
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